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SPECIFICATIONS

SYSTEM
REQUIREMENTS

Windows® 95/98/ME/NT4/2000/XP/Vista

COMMUNICATION

RS-232 adapter or RS-422/485 adapters with an
RS-232 to RS-485 converter may be used for
communicating with the meter(s)

NUMBER OF Up to 100 meters simultaneously with addressing
METERS capability (up to 60 seconds scanning delay)
BAUD RATE 2400 bps to 19.2 kbps

Data logging: log to HTML file format

Configuration: save configuration to PDC file format
PR or export to HTML file for printing, cloning, or

restoring meter settings
CONFIGURATION Configure one meter at a time

Log data to HTML file. All enabled meters are
LOGGING logged to a single file.

Logging interval: 2 seconds to 60 hours or manual

ORDERING INFORMATION

Meterview

Free Software Download at www.predig.com/meterview

Trident Meter Models

85-265 VAC* | 12-36 VDC* Description
Model Model P
PD765-6R0-00 | PD765-7R0-00 | No options

PD765-6R0-10

24 V transmitter supply

PD765-6R2-00

PD765-7R2-00

2 relays

PD765-6R2-10

2 relays & 24 V transmitter supply

PD765-6R3-00

PD765-7R3-00

4-20 mA output

PD765-6R3-10

4-20 mA output & 24 V supply

PD765-6R3-20

4-20 mA output & dual 24 V supplies

Trident X2 Meter Models

PD765-6X0-00

PD765-7X0-00

No options

PD765-6X0-10

24 V transmitter supply

PD765-6X2-00

PD765-7X2-00

2 relays

PD765-6X2-10

2 relays & 24 V transmitter supply

PD765-6X3-00

PD765-7X3-00

4-20 mA output

PD765-6X3-10

4-20 mA output & 24 V supply

PD765-6X3-20

4-20 mA output & dual 24 V supplies

To request meters with Modbus option enabled, replace the last digit with a “1”.
Modbus option may be ordered separately by requesting P/N: PDN-MODBUS
*All models may be powered from AC or DC, see PD765 Instruction Manual for details.

Accessories

Model Description

PDA7420 7' (2.1 m) Standard Modular Cable

PDA7232 RS-232 Serial Adapter (includes PDA7420)
PDA7422 RS-422/485 Serial Adapter (includes PDA7420)
PDA7485-N RS-232 to RS-485 Non-Isolated Converter
PDA7485-| RS-232 to RS-485 Isolated Converter
PDA8485-N USB to RS-422/485 Non-Isolated Converter
PDA8485-| USB to RS-422/485 Isolated Converter

METERVIEW 3 INSTALLATION

1.
2.
3.

No oM~

Go to www.predig.com/meterview
Quickly register

Read instructions & copy serial # of desired MeterView
version

Download Installation file to computer
Double-click installation file to open it
Double-click Setup.exe to begin installation
Follow on-screen instructions

Notice!

This software may only be installed on a single computer. It
may not be shared over a network or otherwise used on more
than one computer at a time, except for the purpose of remote
programming of meters. For complete terms refer to the End
User License Agreement (EULA) found in the MeterView 3
registration window.
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METERVIEW 3 VERSIONS Enable Meter and Select Meter Address

MeterView 3 comes in three different versions:

The actual meter address is set up at the meter using the front

panel buttons. The location where a meter is displayed is
o PDA7503-1 — Supports 1 meter selected on MeterView Main window.
(TS PR To enable or select a meter with a different serial address:
e 1. Right-click on the screen location of meter.
Meter b0 -+ ;Lzﬁ'sm 2. Click on Enabled, if meter is not yet enabled.
It F s | b | 3. Click on Change Address.
N BRECSION 4.

Select meter address to display in this location.

—ari

& COM1 (4 00 [ Update rate: 1 sec L Loggngstopped @ 1053 _|[21 3/13/2008

e PDA7503-2 — Supports up to 10 meters w:Ehablsd
| Change Address el
e ) Maode B MoRelays
3. ™25 e Configure v Relays
i ——— Cuskomize ;
EE 738 -
‘}E E ~ Mater Nnil'a.a ::,::2?,::? Settings
NN
== e ] o] METERVIEW 3 MAIN WINDOW
L [RER PRECISION
. | — The main MeterView 3 window shows the present
& COM1 £ 01 & Update rate: 2 sec. S L G018 = 3/13/2003

reading(s), relays/alarm status, tag number(s) and selected
engineering units, along with other information for each

o PDA7503-3 — Supports up to 100 meters meter. The graphic below indicates the different parts of the

main MeterView 3 window.
155 MeterView 3.0 - Tab 1 BEX]
File Edt View Comm Help
Tabs | Tab7 | Tabg | Tabg | Tab10 | r ~
A | Tab2 | Taba | Tab4 | Tab5 | 5 MeterView 3.0 - Tab 1 | =1 |
Hal it 4 File Edit View Comm Help
a0 ek
U | Tab? | Tabg | Taba | Tab1o |
= i Tab2 | Tab3 | Tab4 | Tabs
BE 135 -
Lo | ok | N or |
nnnnnnnn .0gging Settings
‘}ES -,' ‘} |;|I=rva|: -
. e N |
,,,,,,,, o gt | e |
115 1 —_—
& - PRECISION
.y B | -
@ CoM1 (£ 35 & Update ate: Ssec T Logangstopped (@ 1013 |2 3/13/2003

- [ Logging Settings -
Interval:

; 2 ] [seconds =
— ; Stat R

PRECISION
DIGITAL =

RUNNING METERVIEW 3 THE FIRST TIME

The first time MeterView 3 is run it is necessary to set up the
serial communication settings of the program. Select the

communication port and the baud rate Of the meter(s) o EUM\ »}(35 {8 Update rate: 9 sec | Loohing stopped ™, €8 1013 [[E 3/13/2003
connected.
= Meter displa . .

6 Serial Setup play Engineering

EoMi +| compor \ units

2400 | Baud LCancel ./

Tag number CE)
Note: The selected baud rate in MeterView and the meter(s) baud rate Y ,J'
must be the same. Otherwise a communication error will occur. Relays/alarms -

status indicators

Address being scanned Logging

System date

F 00)/& Update aie: 1 sec_

/
COM port Update/scan

System time
used
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Main Window Menus

The MeterView 3 main window contains the following menus:
e File menu

o Edit menu

e View menu

e Comm Menu

e Help Menu

File Menu
The following options are available from this menu:
1. Save Settings to save the present window settings.
2. Exit to close the MeterView 3 program.

Edit Menu
The following options are available from this menu:

1. Serial Settings to edit the serial communication settings.

View Menu
The following options are available from this menu:

1. Event Log to view the MeterView 3 event log window
where all internal program events and errors are logged.

2.Show Relay Alerts select whether or not MeterView
should alert the user of a change in the relay status (ON
- OFF or vice versa) with a pop-up message.

Comm Menu
The following options are available from this menu:

1. Stop to halt the automatic meter scanning. This allows
quicker access to menu items, functions, and windows.

2. Start to resume the automatic meter scanning.

Help Menu
The following options are available from this menu:

1. Register MeterView 3 to launch the registration program
to register your copy of MeterView 3.

2. About opens a window that provides the product number
and version information. You should have this information
available in the event you must contact Precision Digital
Technical Support.

& About MeterView 3

MeterView 3

“ersion 3.01 - Build 0200

PRECISION
DIGITAL =
Licansed o PO Emaines

LS| PRGN LR Do aradan
e

o ey T NET ™ U
Sl i 5T T b System Info...

Right Click Menu

By right clicking on a meter on the screen a menu will
appear with the following options:

Menu ltem Function/Submenus
Enabled Enable or disable a meter on the screen
Change Address Change a meter’s serial address in MeterView
Mode Select whether relays/alarms are shown or not
Configure Access the configuration window for a meter
Customize Customize how a meter looks on the screen

i
v Enabled
Change Address | |
Mode 3 Mo Relays
Configure v Relays
- | Cuskomize
Notes:

¢ Due to the intensive processor usage, it may be necessary
to click more than once before a submenu or function is
launched.

e Accessing menus or other windows could disrupt
communication with the meter(s).

e Use left mouse button or tab key on the keyboard to
navigate within a window.

e Parameters not available within a window appear grayed-
out.

e An arrow next to a box indicates a drop-down menu. Click
on arrow to display the drop-down menu.
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CONFIGURATION WINDOW

Click on Configure in the right click menu to open a meter's
configuration window. The following settings can be
programmed from this window:

1. Input type (4-20 mA, 0-10 V, RTD, or TC).

2. Decimal point for process inputs (dd.dd).

3. Units (F or C) and sensor type for temperature inputs.

4. Values for scaling process inputs, values for scaling
analog output, Password, Adjust (temperature only),
Filter, Bypass, Cutoff (process inputs only), Transmit
Delay, Function type, and Cut-off.

5. Relay settings.

6. After the last change has been made, click the Write to
Meter button or press Enter on the keyboard to send the
new settings to the meter, or click on Exit to abandon
changes. Before sending the new settings, MeterView 3
will ask to confirm that the meter’s current settings should
be overwritten. Click Yes to overwrite the settings, or No
to abort the operation and return to the configuration
window.

The configuration window contains the following menus:
e Filemenu
e Tools menu
e Password menu

Note:

e Accessing menus or other windows could disrupt
communication with the other meter(s).

File Menu

The following options are available from the File menu:
1. Save Configuration to save the present settings to a file.
2. Load Configuration to load settings from a file.

3.Export to HTML to save the present settings to a HTML
file.

4. Import from HTML to load settings from a HTML file.

Tools Menu

The following options are available from the Tools menu:
1.Restore Meter to restore a meter to settings previously
saved in a configuration file. The restore operation will
only work with the meter whose settings were originally
saved to the file.

2. Load Defaults to load the factory default settings.

It is recommended to create a
configuration file before
changing any setting and before
any calibration operation.

Password Menu

The following options are available from the Password
menu:
1.Lock Meter to lock the meter and prevent unauthorized
changes.
2.Change Password to change the unlock password of the
meter.
3. Unlock Meter to unlock the meter and allow changes to be
made.

The password must be a four-digit
number; “0000” is the unlocked
password setting.

Input Tab

In the configuration window, click on the Input tab to view
the input options.

Hf Meter Configuration - Meter #00 @
File Tools Password
Input | Scaling | Relaps/Alams | Advanced | Factory Values |
Input Type Temperature Unit
4to 20 mé bt
Decimal Point Temperature Sensor

dd.dd ha

Write to Meter Read Meter Exit

] Source of configuration: Default seltings.
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Set Up Input Type

Click on the arrow next to the 4 to 20 mA box and then click
on the desired input type.

Input Type
4t020ms v

4 ko 20 mé,
Oto 10

Themocouple
RTD

11 44 =0

=

Set Up Decimal Point

Click on the arrow next to the dd.dd box and then click on
the desired decimal point position. Decimal point selection
is available for 4-20 mA and 0-10 V inputs only. The display

scale and relay set/reset points are adjusted according to
the decimal point selection.

Decimal Point

dd.dd -]
ddd d
dd. dd
d.ddd
dddd

Set Up Temperature Unit

Click on the arrow next to the Degrees F box and then click
on the desired temperature unit. Temperature unit selection
is available for Thermocouple and RTD inputs only.

Temperature Unit
Degrees F _:J

Degrees C

Set Up Temperature Sensor

Click on the arrow next to the Type J box and then click on
the desired temperature sensor. Temperature sensor

selection is available for Thermocouple and RTD inputs
only.

Thermocouple Sensors RTD Sensors

Temperature Senzor

|T_|,||:IEJ _:_J

Temperature Sensor

Tone 1100 Ohm PLRTD (385] |
Type K TO0 OFm ELETD 1368

Tepe T 100 Ohm Pt RTD [392]

Type T (017

Type E

Scaling Tab

In the configuration window, click on the Scaling tab to view
the scaling settings for process inputs (current and voltage).

1T Meter Configuration - Meter #00 @
File Tools Password

Input {Scaling | Relaps/Alarms | Advanced | Factory Values |

Current (mA)

Voltage (V)

Input 1 Display 1 Input 1 Display 1
[ 4.00 | 4.00 [ 0 [

Input 2 Display 2 Input 2 Display 2
| 2000 | om0 [ 0 [ T

E—ﬂ@ it o Meter Bead Meter Exit

|2 Source of configuration: Default settings.

Relays/Alarms Tab

In the configuration window, click on the Relays/Alarms tab
to view the settings for the relays/alarms.

H Meter Configuration - Meter #00 @
Fie Tools Password

5| Advanced | Factory Values |

Relap/Alarm 1

Relay/Alarm 2

Fail-Safe [~ Fail-Safe [~
Mode Mode
[Automatic Feset ~| | Automatic Reset |
Set Point On Delay (ms) Set Point On Delag (ms)
[ 7.00 | 0 | 1000 [ 1

Reset Point Off Delay (ms) Reset Point

Off Delay [ms)
[ £.00 | i |

200 [ i

H@ Witsto Meter | Riead Meter | Edt

&) Source of configuration: Default settings.

Advanced Tab

In the configuration window, click on the Advanced tab to

view the advanced settings. Consult the meter manual for
further details.

b'ﬁ Meter Configuration - Meter 00 @
Eile Tools Password

Input | Scaling | Relays/Alaims {Advanced”| Factary Values |

Adjust Value Lockout Installed = =z
’—U.E o Status Option | 753

Analog Output [mA)
Filter Value Intensity

[ o [

Display 1 Dutput 1
400 400
Bypass Yalue Function Type Displap 2 DOutput 2
[ ex [Lingar =l 20,00 2000

Transmit Delay Cutoff Value

Wms ~ RS422 ]W Sensor Break 3.00

wfrite b Mater Bead Meter ] Exit ]

| Source of configuration: Default settings.
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Factory Values Tab

In the configuration window, click on the Factory Values tab
to view the meter serial number, version, and calibration
constants.

H Meter Configuration - Meter #00 @

File Tools Password

Internal Calibration Values
Firmware Number Gain  Offset e
T Current 00340445 02010438
Voltage 00171813 04467163
Cemne e Test 001R3000 00507000
TC Typed 10413320 73904660 3383006
He TCType K 10414040 7RIAING 3330576
TCType T 10402630 7700743 3332038
Meter Serial Number | TC Type £ 1.0416330 8101336 3392675
[ Ganziiaz; | RTDASS 10318320 8425083
RTD A392 10318320 425093
Analog Out 250000000 10,0000000

H@ drite b Meter Head Meter Exit

& Source of configuration: Meter at address 00

CUSTOMIZE WINDOW

Click on Customize in the right click menu to open a meter’'s
customize window. The following settings can be
programmed from this window:

1. Tag Number to identify a meter and optionally display it on the
meter. Pre-selected special characters may be used in this field
by simply dragging the desired symbol into it.

2. Display Units to identify the engineering units of the value being
read and optionally display it on the meter. Pre-selected special
characters may be used in this field by simply dragging the
desired symbol into it.

3. Display Color to change the color of the meter display on the
screen.

4. Relay Tag to change the text label of the Relay Status
indicator(s).

5. Relay Color to change the color of the Relay Status indicator(s).

& Customize Meter - Meter Meter #00
Tag Humber Special Symbols
I Shaon Dk et g basind

Ak madd | | ot 3 fether

Meter HOO A EEEBE EE
Display Units IMERAEE
v Show
# et mad | - Display Color
i
Relay 1 Relay 2
Ontag /i cham mas Ontag /i cham mas
|on |on
On color On color
Off tag /i o mas Off tag /i cham s
|oit |oit
Off color Off color
oK LCancel |

Note:
o These settings are NOT saved to the meter.

SERIAL COMMUNICATION SETUP

Addresses for Trident Meter
and MeterView 3 are set to 00
at the factory.

1.From the main window, click on Edit > Serial Settings
menu to access the Serial Communication Setup.
2. Select correct communication port used for Serial Adapter.

3. If timeout error is received, try another serial port selection
or check meter’s address.

To change the serial address of a meter, simply click on
Change Address in the right-click menu. This setting is on a
per-meter basis.

ﬂ% Change Meter Address @
Current Address:
L] Ok
New Address:
Cancel
] i A—]

Note:
e Baud rate is set up for 2400 bps at the factory.

RELAYS/ALARMS STATUS

Each meter enabled in the main MeterView 3 window can
display the current status of its relays/alarms (if the meter
Mode in the right-click menu is set to Relays) and can allow
the user to remotely acknowledge the relays/alarms (if
applicable). The text labels and colors for the status indicators
may be customized through the Customize window.

Meter #00

=
e B

|Cli|:k ko aknowledge relay,l'alarm|

Note:

e See the PD765 Instruction Manual for more information
about relay operation and acknowledgement.



MeterView® 3 Software

Instruction Manual

LOGGING METER DATA TO FILE

1.Click on the arrow next to the Interval box to select an
interval from 2 to 60 or select manual to log the data only
when the Log button is clicked (Log button is only visible
when manual is selected).

2. Select seconds, minutes, or hours.

3. Click the Start button.

4.Select file location and enter a file name. Click OK.
MeterView 3 will begin logging data to the file.

Logging Settings -
Intervak

Logging may be paused or stopped at any time. MeterView 3
will indicate logging and paused status with corresponding
message flashing in the main window status bar. When
logging, all other MeterView functions and windows are not
accessible.

Log File Sample

The HTML log file format contains pertinent information
related to the meter and logging selections. Each log entry
includes date and time, tag number, serial address, display
value, units and relays/alarms status.

Disclaimer:

The information contained in this document is subject to
change without notice. Precision Digital makes no
representations or warranties with respect to the contents
herein, and specifically disclaims any implied warranties of
merchantability or fitness for a particular purpose.

MeterView® is a registered trademark of Precision Digital
Corporation.

Microsoft, Windows, Windows NT, Microsoft Internet Explorer,
and the Microsoft Internet Explorer logo are either registered
trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe, the Adobe logo, Acrobat, and the Acrobat logo are
either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

How to Contact Precision Digital

¢ For Technical Support please
call: (800) 610-5239
fax: (508) 655-8990
email: support@predig.com

¢ For Sales Support or to place an order
please

call: (800) 343-1001
fax: (508) 655-8990
email: sales@predig.com

e For the latest version of this Manual
please visit

www.predig.com

e For Interactive VirtualMeter Demo please
visit

www.predig.com

LIM7503_C
SFT024 v3.01 & up
07/09



